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Introduction 
The Floor Broker Workstation (FBW) provides the electronic entry of orders into the 
NYSE/Amex market by member floor brokers. FBW resides on a desktop and a mobile wireless 
unit to enable the floor broker to efficiently enter a customer's phone order from the broker's 
booth, or from a trading crowd. Brokers have the ability to enter orders, route orders between 
other units (both mobile and desktop), enter contra orders and submit orders to the market. 
 

Order Ownership/Owner Transfer Order Maintenance 
FBW allows the user to modify orders prior to submission to the order book official. This type of 
order maintenance is typically employed by a Booth user sending order changes and cancels to 
other users. Orders that are “owned” by the user can be modified by the user.  
 

Pre-OBO Submission Maintenance 
Users can change orders that have not been submitted to the OBO (Order Book Official). Once 
an order has been approved by an OBO, it must be cancel/replaced to make changes. 
 

Communication between Mobile and Stationary Workstations 
The ability to move orders is accomplished by changing “ownership” of an order. The ownership 
of an order determines the person responsible for changes to the order. 
 

The FBW feature set includes the capability to change ownership in the following directions: 

 From stationary workstation to Mobile user 
 From Mobile user to stationary workstation 
 From stationary workstation to stationary workstation 

 

The Floor Broker Workstation Screen 
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Chapter 1: Viewing Market Data 

The Markets Window 
The primary function of the Markets window is to give immediate, real-time access to Option 
Market data for the generation of an order ticket.  
 

Markets windows provide a structured market format for viewing option chains. By default, the 
Markets windows display the option chains by strike price in ascending increments. Details of this 
structure typically include Bid and Ask price as well as size for both calls and puts.  
 

A Markets window is divided into two sections: 
 

 The Quote Pane is located in the top section of the window, and provides information about 
the underlying 

 The Market Pane – located directly beneath the Quote Pane and linked directly to it - contains 
the option quotes relating to the underlying. The list of columns can be easily displayed, 
formatted, concealed or moved as needed. See Chapter 4 to learn how to configure windows.  

 

Bring up a Markets Window 

 

Market data is displayed in the Markets window.  Click on the Markets icon to retrieve it, 
or choose Markets from the View menu on the application toolbar.  

 

 
 

To view market data for a security: 
 

1. Type the Underlying Symbol or Option Root in the text box at the top of the Markets 
window. 

 

 
 

2. Select the Expiration Month in the dropdown box to the immediate right of the Symbol text 
box. 

 

3. Choose a number of strikes from the Strikes drop-down list.  
 

The Quick Switch Buttons at the bottom of Markets windows can be used to quickly switch 
between symbols. Click the Quick Switch button displaying the symbol you want to view quotes 
associated with it. To learn how to add Quick Switch buttons to the Markets window, go to the 
Add Symbols to Quick Switch Buttons section in Chapter 4. 
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VIEW ADJUSTED CONTRACTS 

 

If an underlying has adjusted contracts (due to stock splits, dividends, etc.), an 
Adjusted Contracts icon will appear in the Quote Pane between the Symbol and 
the Expiration fields (see the image above).  

 

To view adjusted contracts, simply click on the Adjusted Contracts icon. Click the icon again to 
stop viewing the adjusted contracts. 
 
VIEW ALERTS 

 

Alerts are issued when users should be made aware of situations regarding the 
application, system, data feeds, communication lines, or Exchanges.  

 

When LiquidPoint or NYSE/Amex Operations issues an alert, the Alert icon flashes red. Click 
the icon to open the Alerts window, which lists all alerts issued that day. The most recent alerts 
are listed at the top. 
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Chapter 2: Placing Orders 
Order Tickets 
Straight (Single-Leg) Order Ticket 
Straight (single leg) orders are made up of tickets that buy calls, sell calls, buy puts or sell puts. 
Default values can be assigned to most of the fields on the order tickets; the default value of the 
Quantity field is 10, unless the user explicitly sets a different Quantity default on the Order tab of 
the Preferences screen (see Chapter 4). 
 
This section describes how to configure a Straight order, but also details the order process from 
start to finish. Descriptions of other order tickets will follow - refer back to this section for general 
order entry instructions.  
 

1. Bring up the Markets window. 
 

2. From the Market Pane, enter the underlying inside the Symbol field. You can also select 
a symbol from one of the Quick Switch buttons, located at the bottom of the window. 
See the Add Symbols to Quick Switch Buttons section in Chapter 4 to learn how to 
configure Quick Switch buttons. 

 

3. Click the Bid or Ask on the desired call or put, and then click the Order Ticket icon  
on the Markets toolbar to open up a New Order ticket. 

 

 
New Order ticket 
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4. Modify the ticket using the required fields or buttons: 
 

 Buy/Sell, Open/Close option buttons 
 

 Quantity: type the amount inside the field, or select a quantity from the list box 
below. The + and – buttons add or subtract value. 

 

 Price: use the selected price, or from the list below, or click a price from the Price 
Summary table. 

 

 Order Type: e.g., LMT, MKT 
 

 Clr Acct: Clearing account – type or select an OCC number  
 

 CMTA: If there isn’t a CMTA, scroll down to the blank space. 
 

 Range: e.g. Customer, Firm, B/D - If a Market Maker (MM) range is selected, Sub 
Acct. and Acronym fields will appear and must be completed for the order to be 
correctly routed. 

 

 Acct: choose an account associated with the login, or select an account from the list 
below the Acct# field. Double clicking the account will populate the ticket with linked 
clearing information. See the Clearing Tab section in Chapter 4 to learn about 
clearing links.  

 

 Timing: e.g., Day, IOC, etc. 
 

 Destination: Check the Destination box and choose a route from the list below – 
directly to an exchange, a broker, or to another owner.  

 

 Stage: check the box to submit a Staged order.  
 

 Owner: The selected entry inside the Owner list box defaults 
to the login used to sign into the application. Select another 
entry inside the box to change the Owner. Changing the owner 
to a Booth user will also change the status of the ticket to 
Staged. See the Booth User Guide for more information 
about Stage orders.  

 

 Targeted Resp.: Targeted Response. This checkbox is restricted to mobile floor 
brokers entering the Contra side of a crossing order. It is not applicable for 
originating orders. See the end of this section for a more detailed explanation 
and some examples.  

 

 Send to OBO: Checking this box sends the order directly to the Order Book 
Official.  

 

 Keep Ticket Open: Check this box – located in the 
bottom-left corner - to keep the ticket open after submitting 
the order.  

 

 Ellipsis: Click the ellipsis – also located in the bottom-left corner – to access 
the Preferences screen. Learn more about default preferences in Chapter 4, 
Configuring Windows and Preferences.  

 

5. Click the Send button to submit the order. The system will display a prompt, requesting 
confirmation of the order.  
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5. Click the Yes button. The order will be routed as directed based upon the choices in the 
order ticket.  When the Send to OBO is selected, the order status will change to Pending 
Approval and will be viewed by the Order Book Official. 

 

 
 

6. The Order Book Official releases the order. The system timestamps the event, and 
displays the notification to the broker.  
 

7. The mobile user chooses the Clear The Book option by right-clicking on the approved 
order in the Order Status window. A new order is sent to the exchange, and any client 
orders at the top of the book are removed.  

 

 
 

8. Once the order has been cleared from the book, the Add Contra Order option on the 
right-click menu becomes accessible. Contra order tickets can only be generated within a 
limited timeframe that is determined by exchange rules. Learn about generating Contra 
tickets in the next section.  

 

 
 

 
 

  

If the Send button is 
not accessible, some 
required information 
is still missing. 
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Contra Order ticket 

Once the Contra ticket 
appears: 
 

1. Make any necessary 
changes to the ticket. If you 
are accepting an Approved 
order from another floor 
broker, check the Targeted 
Response box.  

 

2. Fill out the Contra panel at 
the bottom of the ticket 

 

3. Click the Send button to 
submit the order. 

 

FILL OUT THE CONTRA PANEL 
To fill out the panel: 
 

1. Click on a cell in the Badge column, and choose a number from 
its drop-down list.  

 

2. Enter a value of your choice inside the Amount field.  
 

Once the order is submitted, the system will send this side of the trade to 
the OX ME as a FIX Floor Cross. The other side will be sent by the 
other party.  

 

 
TARGETED RESPONSE: POST-OBO APPROVAL ORDER AFFIRMATION PROCESS 
After the Order Book Official approves an order and the Floor Broker brings it to the crowd and 
trades with another Floor Broker, the broker taking that trade must indicate acceptance of the 
OBO-approved order by sending an order with the Targeted Response box checked. Order 
tickets filled out and sent with the checked Targeted Resp. box will not return for OBO approval, 
and are directly sent to the exchange.   
 
Example 

1. Floor Broker Badge #123 enters order to buy 100 xyz, sends to OBO 
 

2. OBO approves. 
 

3. 123 enters the crowd and trades as follows: 
 

 50 with Market Maker #456 
 20 with Floor Broker #789 
 30 with Floor Broker #101 
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4. The trade side for the 50/Market Maker contra is sent to the exchange.  
 

5. The buyer enters and sends the following information to the exchange: 
 

Buy 20 xyz @ [price] = 123:789 
 

 Click the Buy option button 
 

 Enter 20 inside the Quantity field 
 

 Enter the Price inside the Price field.(underneath the Order Type drop-down list) 
 

 Select 789 from the Clr. Acct drop-down list 
 

Buy 30 xyz @ [price] = 123:789 
 

 Click the Buy option button 
 

 Enter 30 inside the Quantity field 
 

 Enter the Price inside the Price field 
 

 Select 101 from the Clr. Acct drop-down list 
 

6. Floor Brokers 101 and 789: 
 

 Enter their own CMTA, Clearing and Account information at the top of their tickets 
 Fill the Badge and Quantity inside the Contra panel for the buyer  
 Check the Targeted Response box and send the trades to the exchange. 
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Spread Order Ticket 
While a Spread order ticket’s order contents are similar to a Straight order ticket in terms of 
required fields and information, there are some exceptions:  
 

 Up to three legs can be entered on the ticket to create a Spread 
 

 A Leg Summary panel is included in the ticket allowing each leg’s Buy/Sell and 
Open/Close options, Quantity and Ratio values to be modified. 

 

1. Open up a Markets window, and 
follow Steps 1 through 3 from the 
Straight Order Ticket instructions.  

 
2. Right-click on a Bid or Ask on the 

Markets screen and select Add Leg 
to Order to create a second leg. 

 

 
 

3. To create a Multi-Leg spread order, 
continue to add up to 2 more 
additional legs by repeating step 2. 

 
4. Fill in the required fields as described 

in the Straight order instructions. 
 

5. Click the Send button to submit the 
order. 

WORKING WITH THE LEG SUMMARY PANEL 
 

Editing the Bid/Offer, Quantity value, 
and individual Buy/Sell, Leg Quantity 
and Leg Ratio fields will dynamically 
change other areas of the Spread ticket. 

Bid/Offer 
Changing the Bid/Offer value on the ticket flips all of the individual Leg Buy/Sell values inside the 
Leg Summary panel. With the exception of a Market order, it also flips the Debit/Credit value of 
the ticket.  
 

Leg(s) Buy/Sell 
While changing Buy/Sell values for legs doesn’t dynamically change the rest of the ticket, the 
prices of the modified legs will dynamically change to match the leg’s Buy/Leg status. 
 

Leg Summary
 panel 
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Quantity 
Editing the Quantity field on the ticket will dynamically change the individual Leg Quantity fields to 
equal the Quantity multiplied by the individual Leg Ratio, but leave the individual Leg Ratio 
fields unchanged.  
 

Example 
 

  

If the if the order Quantity is 10 and the Leg 1 Ratio 
is 1, the Leg 2 ratio is 2, and the Leg 3 ratio is 1, the 
Leg 1 Quantity will be 10, and the Leg 2 Quantity 
will be 20 and the Leg 3 Quantity will be 10. 

 

If you change the Quantity to 20, the Leg 1 
Quantity will change to 20, the Leg 2 Quantity 
will be 40, and Leg 3 will change to 20. 

 
Leg Quantity 
Modifying the Leg Quantity field will cause the individual Leg Ratio fields and main Quantity field 
to change. Follow these steps to determine the ratios and quantity: 
 

Calculate the Greatest Common Denominator (GCD) of all Leg Quantity values 
 

Each leg (x) Ratio = Leg Quantity/GCD 
 

Value in main Quantity field = GCD 
 
Example: Leg Quantities Share GCD Evenly – Quantity Does Not Change 
 

Quantity (GCD) = 5 
Leg 1 Quantity = 5 and Ratio=1 
Leg 2 Quantity = 10 and Ratio = 2 
Leg 3 Quantity = 10 and Ratio = 2 
Leg 4 Quantity = 5 and Ratio = 5 

When Leg 4 Quantity Changes to 30: 
Changing the quantity in Leg 4 from 5 to 30 will 
change the Ratio to 6, and since 5 is the GCD, the 
value inside the main Quantity field does not change.  

 
Example: Leg Quantities Do Not Share GCD Evenly – Quantity Changes to GCD 
 

Quantity (GCD) = changes from 5 to 1 
Leg 1 Quantity = 5 and Ratio=1 
Leg 2 Quantity = 10 and Ratio = 2 
Leg 3 Quantity = 10 and Ratio = 2 
Leg 4 Quantity = 5 and Ratio = 7 

When Leg 4 Quantity Changes to 7: 
If you change Leg 4 Quantity field to 7, the GCD for 
all leg quantities will change to 1, so the main 
Quantity field will change to 1.   
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Stock Order 
Stock order tickets are also available in FBW, accessed by right-clicking on the Bid or Ask on the 
Quote Pane, and selecting the Straight Stock Order menu option.  
 

 
 

 
Straight Stock Order ticket 
 

1. Fill out and submit the Stock ticket the same way you would a Straight Order ticket.  
 

2. Click the Send button to submit the stock order.  
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Staged Order 
A Staged order can be generated by clicking to check the Stage box on 
an order ticket before sending an order, or by accessing an Order with 
the status of Stage from the Order Status window.  Staged orders in the 
Floor Broker Workstation will capture current quote information, but they 
will never be routed.  

 

 

To submit a Staged order from the Order Status window, 
click on the order with the status of Stage, and the ticket 
will open for processing. 
 
 

At this point, users can make corrections or modifications 
before clicking the Send button. The order will appear in 
the Order Status window and process in the usual manner 
based upon the options chosen on the ticket. 
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Buy/Write Orders 
1. Open a Markets Window. 

 

2. Retrieve a Straight Stock Order ticket by right-clicking on the Bid or Ask price in the 
Quote Pane, and selecting Straight Stock Order. 

 

3. Go back to the Markets Window and right-click on the Bid or Ask price for the Call or 
Put you want as the second leg of the order. 

 

4. Select Add Leg to Order from the menu to change the Stock ticket to a Spread Order 
ticket, with a ratio of 100:1.  

 

 
 

3. Complete the ticket, and click the Send button to route the order. The spread will appear 
in the Order Status: window.  

 

Delta-Neutral Order 
STEP 1: LEG SELECTION 

1. From the Markets window, double-click on a Bid or Ask of the underlying, and 
then click the Order Ticket icon to launch a New Order ticket. 
The stock leg of a complex order involving stock must be created first. 

 

2. Right-click on the Bid or Ask of the next leg of the complex order 
and select Add Leg to Order. The New Order ticket will become a 
Spread Order ticket with Stock as one of the legs of the spread. 

 
3. Repeat step 2 until leg selection for the complex order is complete. 

 
STEP 2: RATIO SELECTION 

 
Leg Summary panell 

The ratios of the legs will default to 1:1, meaning 100 shares of stock against 1 option. If the 
spread is in a ratio other than 1:1, the ratios must be adjusted using the Ratio field, next to the 
Leg Summary table on the lower right side of the ticket. The spinners next to the Ratio field may 
be used to increment or decrement the ratio values, or the values can be typed directly into the 
fields.  
 
Changing the ratios will result in contract quantity changes inside the Quantity box in the Leg 
Summary panel and the implied spread prices in the Regional Quote table, including the sNBBO. 
 
STEP 3: SETTING UP THE RATIOS OF A DELTA-NEUTRAL ORDER 
In order to construct a delta-neutral order, the ratio fields must be used to specify the necessary 
delta by entering the number of shares that need to be executed per option, or per spread. 
 

1. Launch a complex order ticket with stock as described in Step 1.  
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2. Modify the ratio fields to specify the required delta and leg ratios; alternatively, the total 

quantity of all legs may be entered into the Quantity fields to the left of the Ratio fields. 
 
STEP 4: SETTING THE RATIOS 
Example: User would like to buy 5500 XYZ stock and sell 100 of the XYZ December 21 calls 
on a 55 delta.  
 
Enter the Quantity directly                          Set the Delta first                   Specify the Quantity 

                                        
 
COMPLEX SPREAD NET PRICING 
Complex spread net prices are calculated according to a formula used by the Exchanges to aid in 
processing these structures electronically. Leg Ratios are reduced to the lowest common 
denominators and then multiplied by leg prices to yield a net price which is sent to the Exchange. 
These calculations are generally not intuitive to users and can be confusing, especially with delta 
orders. 
 

To aid users in calculating the correct net prices for complex structures, FBW includes a Spread 
Calculator, located just to the right of the Leg Summary panel.  
 

 
 
The Spread Calculator aids users in calculating the proper Net Price of a multi-leg, multi-ratio 
complex spread by allowing the user to enter the individual prices of the legs and the appropriate 
ratios. Users can left-click on prices in the Regional Quote Panel, or enter prices directly into the 
Price fields of the spread calculator. Individual prices can then be incremented/decremented 
using the spinner buttons. The Net Price is then calculated and displayed in the summary field as 
well as in Regional Quote Panel (in the Net Price format) for reference. 
 

Double-clicking the Net Price summary field populates the Limit Field (located 
underneath the Order Type drop down list) of the Complex Order ticket.  
 

 

Cancel an Order 

 

To cancel an open order, click to select an order on the Order Status window 
(discussed in Chapter 3) and then click on the Cancel icon.  

 

  OR THEN 

Spread Calculator 
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Chapter 3: Order Status Window 
Verify the status of orders by using the Order Status window. This chapter describes how to use 
the window and the features associated with it.  
 

 
Order Status screen 
 

Open an Order Status Window 

 

To open up an Order Status window, click its icon on the Application toolbar, or choose 
the Order Status: Orders Pending Approval option from the View menu, also 
accessed via the Application toolbar.  

 

 
 

View the Details of an Order: Prices Window 

 

The Prices window allows users to view the order status and price over time. An entry 
is shown for every status change. To open a Prices window, select an order in the 
Order Status window by clicking on it and then choose the Show Prices icon. 

 

On the right side of the Prices window you’ll find the Bid 
and Ask price and the Bid and Ask size for each of the 
options exchanges. To differentiate between them, each 
Bid and Ask price and size column has an exchange code 
that follows the name of the column; e.g., BidSzA, BidA, 
AskA and AskSzA represent Bid and Ask prices and sizes 
for Amex. The following table lists the code for each 
exchange.  
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Summary Leg Price Window 

 
Use the Summary Leg Price window to generate ad-hoc summary reports of 
prices based on a selection of filled straight or spread orders can be generated.  

 

Access the window by clicking on its icon, located on the far-right side of the Order Status 
window. 
 
After selecting orders, click on the Summary 
Leg Prices icon on the toolbar. Contracts 
sorted and summarized by fill prices will appear 
on the Summary Leg Prices window. 

 
Summary Leg Prices window

 

Daily Activity window 

 
Daily Activity window 
 

Group, sort, and configure the window in the same way as the Order Status window, as 
described in the Configure Windows section in 4.   
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Transaction History: View Historical Data 

 
Transaction History window 
 

 

There are two ways to view historical data by retrieving the Transaction History 
window: 
 

 Click on the Transaction History icon on the application toolbar. 
 
 Click the View menu option on the application toolbar, and select Transaction 
History from the list 

 

 

To populate the window with activity for a day or range of days, click on the Report 
Parameters Icon on the Transaction History window menu bar to retrieve its screen.. 

 

The Report Parameters window provides start and end 
date fields for the transaction data you want to view.  After 
entering the dates in a MM/DD/YYYY format, click OK to 
view a Transaction History window displaying the entered 
results. 

 

The Transaction History Window can be sorted, grouped, and configured in the same way as the 
Order Status Window. Data is only available for the last 90 days. 
 
OPEN A PRICES WINDOW FROM THE TRANSACTION HISTORY WINDOW 
 

 

To get detailed information on a particular transaction, click to select an order in the 
Transaction History window and then click on the Show Prices icon, located on the 
Transaction History window toolbar.  

 

This type of Prices window displays the price and status of the order over time. In the picture 
below, the order was submitted (ExPndOpen) at 3:26:01 PM, then milliseconds later the order 
was open on the Exchange (ExOpen) and filled (ExRptFill) at $0.10. 
 

 
Prices window 
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Place Orders from the Order Status Window 
Some orders must be placed or canceled after viewing an order’s current status.  
 

Generate a Cancel/Replace Order 

 

To open a Cancel/Replace order ticket, select an Approved order by clicking on it, 
and then click on the Cancel/Replace icon. Make any changes to the order in the 
Cancel Replace order ticket  

 

After making changes to the ticket and clicking the 
Send button, you will first be prompted to confirm 
the trade, and after clicking the OK button another 
prompt will appear, asking you to confirm the 
Cancel/Replace.  
 

 
 

Clicking the Yes cancels the original order, and a 
new order will appear inside the Order Status 
window with a Pending Approval status.  

Cancel/Replace ticket

Resend an Order Ticket 
Order tickets may be resent via the Order Status window. Highlight an order record 
and click the Resend icon on the Order Status toolbar; all information on the original 
ticket will appear in the Resend ticket, where you can modify its values.  
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Chapter 4: Configuring Windows and Preferences 
This chapter shows how you can customize your interface to the Floor Broker Workstation by 
setting ticket and order entry preferences, and configuring the layout of your windows.  

Order Ticket Preferences 

Order Ticket Preferences screen displaying Order tab 

 

 
 
 
 
This next section describes each tab on 
the Order Ticket Preferences screen.  

General Tab 
Click the checkboxes on the General tab to display the application toolbar (Toolbar) and to be 
prompted by the application if any windows files (Windows) have changed.  

 
General tab on Preferences screen 
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Order Tab 
For a full view of the Order tab screen, go back to the first page of Chapter 3. 
 

ORDER TYPE 
Select the type of order for which you would like to set or change 
preferences (Straight or Spread). 

GENERATE WARNING POPUPS 
Use the Warnings panel to set to set values at which you would 
like to have a warning pop up before sending an order. If a 
numerical value (other than zero) is entered in either field and an 
order is submitted that exceeds the specified number of contracts 
(Contracts) or the entered dollar value (Market Value), a warning 
pops up on the screen before the order is sent asking if you are 
sure you want to send the order.  

 

 

A zero in either field means allows any number to be entered without generating a warning. 
 
SET CONTRACT QUANTITY AND MARKET VALUE LIMITS 
The Limits panel is similar to the Warnings panel, except in this 
case when a contract or market value limit other than zero is 
entered, an order that exceeds those values cannot be sent. You 
can also limit the percentage away from the market value: entering 
a 10 inside the % Away from Market Value field, for example, 
prevents bids over $1.10 on a $1.00 offer: a 10% limit on a $0.90 
bid prevents offers less than $0.81.  

Prevent Duplicate Trades 
Enter a value inside the Time Interval for Duplicates field to protect against having duplicate 
trades sent by mistake. 
 
SET QUANTITY, OPEN/CLOSE AND TIMING DEFAULTS 
Use the Order panel to set Quantity, Open/Close and Timing (Day, IOC, 
FOK, etc.) defaults.  
 

Selecting None instead of Open or Close will require that the Open or Close 
must be selected on the ticket before the Send button is activated. 

TICKET DEFAULTS 
Change the default behavior of order tickets. 
 

Layout: Choose from this drop-down list the type of order ticket 
that can be opened when you click on a Bid or Ask price in the 
Markets window, or the Order Ticket icon in the Markets window 
(the factory default is Straight). 
 

Position: Select a location where the order ticket should open 
(e.g., Top Right, Center, Bottom Left, etc.). 
 

Keep open after sending: Check this box to allow the order 
ticket to remain open on the screen after clicking the Send 
button.  
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Review order before sending: Checking this box will force a prompt to appear after clicking the 
Send button on an order ticket, asking if you are sure you want to send the order.  
 

Prompt when sending unsupported contingencies to Exchange: Check this box to have a 
prompt appear, asking if you want to send an order with contingencies that are not supported by 
the selected exchange(s).  
 

Prompt when sending to Exchange: Force a prompt to pop up when the destination selected is 
an exchange connection.  
 

Prompt when sending Cancel Replaces: Get a look at the changes from the original order after 
sending a Cancel/Replace by checking the box.  
 

Prompt when Cancel: Selecting this option displays a prompt asking if you want to cancel the 
order.  
 

Checking Display Post and Station: Post and Station to be shown in the status bar of the 
order  
 

Clearing Tab 
In this section you can link clearing information to a specific clearing account, set up accounts 
to be linked to clearing information, set default amounts for fees and assign an Alias to an 
account. 
 

CLEARING: LINKING CLEARING INFORMATION TO 
ANOTHER FIRM 
To link clearing information to another firm: 
 

1. Select the clearing account (Clearing Acct.) you would 
like to set up from the drop-down list. 

 

2. Select the related clearing information (CMTA, Acct#, 
Range, Sub Acct, Acronym, Client, and Trader). 

 

3. Click the Link button. The linked information will 
automatically fill the appropriate fields when you 
double-click on the number associated with the clearing 
account.  

 

If clearing information has not been linked to a clearing 
account, double-clicking the firm account number on the 
order ticket will bring up the last clearing information entered 
on a ticket with the selected clearing account.   

Clearing tab on Preferences screen 

 
CONFIGURE FEES 
Default fees can be entered by clicking the Fees tab 
and entering an amount for one or more categories. The 
up/down arrows to the right of each field can be used 
to increase or decrease the amount by $0.01. 
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ADD CUSTOMER ACCOUNTS (CONFIGURE ACCOUNTS...) 
You can add accounts and link clearing information to them. This is useful if you have two or 
more customers that use the same clearing account. Once a customer account is added and 
clearing information is linked to it, you can double click the customer account on the order ticket 
and the linked clearing information will automatically populate the clearing fields. 
 

1. Click on the Configure Accounts... button to open the 
Configure Accounts window.  

 
Configure Accounts screen 

2. On the Accounts field, type the account name and click the Add button. The account will 
appear inside the Account scroll field found below the Acct# field on the order ticket. 

 

3. Click the Apply button to save the configuration and close out the Configure Accounts 
screen.  

 
Remove a customer account 

1. Click on the Configure Accounts... button to open up the Configure Accounts window. 
 

2. Click to highlight the name of the account you want to remove. 
 

3. Click the Remove button.  
 
 

Routing Tab: Set Order Ticket Routing Defaults 

 
Routing tab on Preferences screen 

Select order ticket routing defaults –  
None or Stage.  
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Misc Tab: Symbol, Market Window and Order Status Defaults 
ADD SYMBOLS TO QUICK SWITCH BUTTONS 
Use the Symbols panel to add or remove symbols that appear as Quick Switch buttons at the 
bottom of the Markets window.  
 

To add a symbol, type it inside the small 
Symbols: window and press the 
<Enter> key. The symbol will appear in 
the list box below.  
 

To remove a symbol, click to highlight the 
symbol’s name inside the list box and 
press the Delete key. 
 

 
 

Misc tab on Preferences screen 

To make the Quick Switch buttons accessible on the 
Markets window, click the Control Menu icon in the 
upper-left corner of the Markets window and choose the 
Toggle Symbols Toolbar option. 

 

Quick Switch buttons 
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Configuring Windows 
This section describes how to format, sort, group and filter columns in FBW windows. It also 
explains how to save and open window layouts.  
 

Configure Columns 
Use the Configure View window to configure and filter your columns. The Configure 
View icon can be found on almost any window accessed from the View menu, or from 
the Tools menu on the application toolbar. 
 

Click the Apply button to save your modifications; click OK to save your work and to close out the 
Configure View screen.  
 

If a Markets window is open, click on the Configure View icon and 
choose between Configure Quote Pane and Configure Market 
Pane. Both options will retrieve the Configure View screen.  

Configure View screen 

 

 
 
 
This first section will 
describe briefly how to add, 
remove, format and filter 
your columns. The next 
section will provide 
definitions of each field on 
each tab screen.  
 
 

ADD OR REMOVE COLUMNS 
From the Columns tab screen, select a column from the Available Columns list box and press 
the Add button. To remove a column, choose an entry from the Selected Columns list box and 
click the Remove button.  
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CHANGE A COLUMN’S COLOR 
From the Format tab screen, click the paint can to change the color of 
the column; click the letter to change the text color. 

FILTERING COLUMNS 
By using the Filters tab screen, columns can be filtered to include or exclude specified items, or 
have an Operator (=, <, >, Sum, etc.) applied to them.  
 

1. Select a column from the Columns: list box.  
 

2. Click the Comparison drop-down list and select an Operator (e.g., =, <>, etc.).  
 

3. Type a relevant value inside the Compare To: box. For example, if you want to view all 
orders with a Bid size greater than 500, you would select the BidSize column, choose  
the > symbol from the Comparison list, and type 500 inside the Compare To: box.  

 

 
 

4. Click the OK button to apply the changes; the filter equation will appear inside the Active 
Filters list box and close the Configure View screen. 

 

 
 
Remove a Filter by highlighting the filter entry inside the Active Filters list box and clicking 
the Remove button.  
 

GROUPING COLUMNS 

 

Views can be sorted, or ‘grouped’, based on column. The Add Group function adds 
groups from the left-most column and then continues from left to right, for a total of up to 
4 groups.  For example, to group by the expiration of an order, drag the Expiration 
header to the first column and click the Add Group icon (the box with the plus sign). 
 

 

A 1 in the upper-left corner will appear, signifying one 
grouping. If another group is to be added, drag another 
column header to the 2nd column and click the Add Group 
icon again. In this picture, the window is grouped by status 
and the strike price. 
 

 

Remove a group by clicking the Remove Group 
icon. 
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Configure View Screen Definitions 
FORMAT 
Columns 
Click to highlight an entry from the 
Columns list box to modify its 
format.  
 

Change the Column Name 
Type inside the Column Header 
field to rename the column header.  
 

Change the Column Font to Bold 
Check the Bold box to turn your 
font to bold.  

Format Column Numbers 
The numbers in the selected column can be formatted using the # sign, zeros, commas, and 
periods. 
 

Apply a Formula to a Column Group Header Row (Aggregate) 
 

The Aggregate drop-down list applies a 
formula to the Group Header row. For 
example, in the Order Status window, 
when orders are grouped by U/L, and 
the Sum aggregate is applied to the Fill 
Qty column, the number of fills is added 
up, with the sum of the fills displayed at 
the top of the group. 

Format Standard Colors 
Click the paint icon to change the column’s background color, and the 
font icon to change the column’s font color. An example (Sample…) of 
how the new configuration will look will appear after clicking the OK 
button. 
 

Format Up Tick/Down Tick Colors 

Use the paint and font icons to configure the Up and Down tick display on 
window columns.  
 

Use Color to Warn of the Presence of a Customer Order at the NBBO 

Select a color and font that will appear in Bid and Ask columns of the Regional Quote panel of an 
order ticket if a customer’s order is on the order book at the NBBO.  
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COLUMNS: ADD OR REMOVE COLUMNS FROM WINDOWS 
Add a column to a window by clicking to highlight a column name from the Available Columns 
and clicking the Add button. Remove a column by highlighting a column name inside the 
Selected Columns list and clicking the Remove button.  

 
Columns tab on Configure View screen 

 

FILTERS 
Filter columns to include or exclude specified items, or apply an Operator to them. See the  
Filtering Columns section in this chapter for instructions.  
 

SOUNDS: GENERATE SOUNDS WHEN A ROW IS ADDED OR REMOVED 
You can apply sounds that initiate when rows are added or removed.  

 
Sounds tab on Configure View screen 

To add a sound, click on the ellipsis (...) button and select a sound from a folder on your system. 
To preview the sound, click on the Play ( > ) button.  
 

To remove a sound, click to highlight the link in the window and press the <Delete> key.  
 

Please note that a sound 
card must be installed on 
your system if you want to 
use this feature.  
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MISC: FORMAT WINDOW GRID SETTINGS 
 

 
Misc tab on Configure View screen 

Change the Line Color of the Window Grid 

Click the Paint Can to retrieve the color palette and choose a different color.  
 

Change the Window Font 

Click the Letter to retrieve the Font dialog, where you can change the font, the font’s style and the size 
of the font. 
 

Extend the Last Column  

Extend the last column length to the end of the Window.  
 

Disable Add Row/Remove Row Color 

Click to check these boxes to disable the highlighting of a row as it is added or removed.  
 

Hide Window Grid Lines 

Click the Vertical, Horizontal or All radio button to hide any or all grid lines. None is the default.  
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Hot Keys: Assign a Task to a Function Key 
Function keys (e.g. F1, F2, etc.) can be configured as short cuts – or Hot Keys - to performing 
tasks associated with the Application Toolbar.  
 

 
Hot Keys screen 
 

To assign a task to a function key:  
 

1. From the Application Toolbar, retrieve the Hot Keys screen by 
choosing Hot Keys from the Options drop-down menu. 

 

2. Click the down arrow on the first unassigned Descriptions field 
and select a task from its drop-down list. The task will be 
assigned to the function key associated with the row.  

 

3. Continue to click other Description fields, assign tasks to other 
function keys, and click the Apply button to save your work. 
Click the OK button to save your work and close out the screen. 
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Open and Save Formatted Windows 
Save the Format of a Window 

 
Click on the Save icon to save the format of a window with its current name.  

 

OR 
 

 

Use the Save As icon to save the window with a different name and to bring up the 
Save window.   

 
Save window 

Type the new name of the formatted window inside the File name: field, and then click 
the Save button to close out the window.  

 

Open a Saved Window Layout 

 
Click the Open icon on the toolbar to retrieve the Open window. 

 
Open window 

Double-click on the file. The selected file will appear on your screen.   
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Layouts Manager 

 

Use the Layouts Manager to create, open and remove layouts.  
To access the Layouts Manager window, click its icon on the application toolbar, or choose 
the LayoutManagerWindow option from the View menu.  

 
Layouts Manager 

Create a Layout 
To create a layout:  

1. Open the Layouts Manager window.  
2. Open all of the windows you want to have included in a layout. 
3. Give the layout a name by typing it into Move To: field.  
4. Click each window entry to highlight it.  

 

 
 

5. Press the <Enter> key. You will be prompted to save your preferences and your layouts. Click 
Yes to both prompts.  

  
 

Opening Layouts 
There are four ways to open a saved layout:  

 Double-click on the Layout Name field in the Layouts Manager window. 
 Select the layout from the Layout toolbar. 
 Press a Function Key assigned to the layout. 
 Configure the windows in the layout to launch automatically when the application opens. 

 

DOUBLE-CLICK ON THE LAYOUT NAME 
With the Layouts Manager Window open, double-click on the name of the layout (in the LayoutName 
column) you want to open.  
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SELECT A LAYOUT FROM THE LAYOUTS DROP-DOWN MENU 
On the application toolbar, you’ll find a Layouts drop-down 
menu.  

1. Click the down arrow of the Layouts menu to display a list 
of all your layouts.  

2. Click to highlight the layout and the menu will expand; click 
the Open button from the menu to display the layout.   

 

Make the Menu a Toolbar 

1. Follow step 1 of the previous section.  
2. Place your mouse on the bar at the top of the menu, 

above the name of the first layout. The bar’s color will 
change from a light blue to a dark blue.  

3. While holding down the left mouse key, drag the menu to another 
location on the Main toolbar. 

 

Make a Standalone Menu Toolbar 

Click on the Layouts toolbar and drag it onto the desktop, or double click on the 
horizontal bar on the far left side of the toolbar. The toolbar will detach from the 
application screen and change to a standalone menu. 
To delete the standalone menu, click the x in the upper right corner of the menu. To 
delete the Layouts toolbar, bring up the standalone menu and click on the x to close it 
out.   

 

ASSIGN A FUNCTION KEY TO A LAYOUT 
Layouts can be opened with a function key.  At the bottom of the layout’s 
drop-down menu is a field for assigning a function key to the layout. Click 
the drop-down arrow on the field and select a function key, which will 
display in the Function Key field and next to the layout name on the 
Layouts toolbar. Selecting the function key at any time will open the 
assigned layout. 
 

AUTOMATICALLY LAUNCH A LAYOUT 
Windows can be assigned to launch automatically 
when the application is opened. From the AutoLaunch 
column on the Layouts Manager window, click the cell 
of the row that represents the window you want launch, 
and then click the drop-down arrow that appears. 
Select Yes to have the selected window open when 
the application opens.  

 

If you decide later that you do not want the selected window to auto-launch, go back to this menu and 
choose No. 
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Control Menu: Toolbar Configuration, Windows Control 
The Control Menu allows users to: 

 Show or hide the Main Toolbar 
 Show or hide the Status Toolbar 
 Show or hide the Column/Tab Toolbar 
 Show or hide the Symbols Toolbar 
 Minimize the window 
 Maximize the window 
 Restore the window 
 Close the window 
 Move the window 

 

To open the Control Menu, click on the icon in the top-left 
corner of the Markets window.  

 
The Toggle switches at the bottom of the menu allow you to show or hide any the listed toolbars in 
FBW. To view or hide any of the toolbars, click on the Control Menu and select the appropriate toolbar 
entry on the list.  
 

Save Column Layouts using a Toolbar 
The Column/Tab Toolbar allows users to quickly change the data display in their open windows. 
Columns can be added, removed, and rearranged, and each change can be saved as a separate 
window layout. Tabs can be set up so that when users click on a tab, associated information 
displays in the window.  
 
COLUMN LAYOUTS 
Column layouts can be created to view information in a variety of ways 
for ease of order entry and reporting. Layouts can be saved with 
columns added, removed, or in a different viewing order. The Column 
Layout Toolbar is used to add, remove, and update column layouts. 

Column Layout toolbar 

 

Default Layouts 
There are some layouts already set up for you. To open any of these layouts, click on the drop-
down arrow in the layout name field and select the layout you would like to view from the 
dropdown list. 
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Add a Layout 

 
Configure the columns in your window so they appear the way you want for the new layout. 

1. Click the Add Column Layout tab. 
2. In the pop-up window, type a name for the column layout. 

 

 
 

3. Click OK. The name of the new layout will appear next to the Column Layout tabs. To open the 
layout, click on the button.  

 
 

Remove a Layout 

 

From the Column Layout toolbar, select the column layout you would like to remove and 
click the Remove Layout tab.  

 

Update a Layout/Rename a Tab 

 

On the Column Layout toolbar, select a column layout, make your changes, and then click 
the Update Column tab to save you modifications. You can also use the Update tab to 
change the name of the button.  

 


